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Setup GPS  

(also laser if used as input) 

1. From the Main Menu , Go to the Settings 

Tab and select 

  GPS and Laser Connections 

2. Use choice A if possible, otherwise, use 

choice B 

 A. If you know your settings for your mobile 

device enter them here by clicking on the Port 

button and the Baud button. Then press Check 

to make sure the settings are valid. Checking 

the settings may take a minute while the  

device looks for a valid signal from your GPS. 

 B. If you do not know your mobile device 

settings click on the Auto GPS/Laser button to 

start the search for the correct COM port and 

baud for your device. This operation may take 

a few minutes. (Note: this operation may not 

work on all mobile devices.)   Then press Check 

to make sure the settings are valid. Checking 

the settings may take a minute while the de-

vice looks for a valid signal from your GPS. 

3. Once you have successfully obtained your 

device settings click the Save button. 

4. Setting the Laser communication is similar 

to doing the GPS settings. Important, once you 

click  Check you must take a shot using your 

range finder to finalize. 

1. 

2. 

3. 
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Create New File 

 

1. On the File page — Click New. 

 

2. Navigate to your selected folder and then 

Enter the name of what you want to call your 

file. (Optional: Create a new folder by selecting 

the New Folder button.) 

 

3. Once you have named your file and 

selected where you want to save it click Save. 

 

4. The Project Info form will automatically pop 

up. Fill in the information about your new pro-

ject. When you are done with filling out the 

form select OK.  

(Note: This form will keep the entries you have 

made as a default for your next project.) 

 

 Drop-Zeros: This setting will drop created 

points automatically where the values of the 

points are all 0 or invalid.  

1. 

3. 

4. 
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Create/Edit Metadata 

1. Go to the Data Tab and select Metadata Edit. 

2. In this form you can fill out your metadata for 

your project. The Default Meta “Meta1” cannot 

be deleted (it can be renamed). To start editing 

the fields click on the Lock checkmark to unlock 

the fields. Be sure to set your  UTM Zone before 

you start collecting points. It is best to set the 

UTM zone manually.  You can try to get it auto-

matically by pressing the Get Zone button. (Your 

GPS must be connected and communicating 

with TwoTrails to use Get Zone).   This will only 

work if the satellites are broadcasting this in-

formation and will only be correct if you are 

standing in the zone you want to use.  Set your 

Magnetic Declination (MagDec) appropriately.  

Remember to set it relative to your compass decli-

nation setting (e.g. set TwoTrails to zero if you 

have your declination set on your compass).  

3. Click the Device - Project tab to fill out more 

information . By clicking on a  List button you can 

see common devices used out in the field to 

auto-populate the text field.  Clicking  the Set 

as Default Metadata button saves the infor-

mation as the default for  future projects. 

4. Click OK to save. 

Notes: Copy Meta button will copy the current 

metadata into a new metadata definition.  Useful  

when only one thing changes,(e.g. receiver dies 

and you switch to another one). 

1. 

2. 

3. 
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Create, Edit or Modify A Polygon  

(Polygon means Unit, Polyline, or Points) 

 

Go to the Data Tab and select Polygon Edit. 

 

 ALWAYS click the New button to create a 

new polygon. 

 

Type a polygon  ID and description.  

 

Though rarely needed, you can choose to 

change the start index of the points in the pol-

ygon by changing the Start Point value.  You 

can also change how points are incremented 

by changing the value of Inc.  

(Note: You must increment points by at least 1 

and it is suggested to have each polygon start 

1000 higher than the previous polygon which 

helps when mapping units at the same time.)  

 

Generally, the MTDC GPS accuracy value is put 

in the Poly Pt Acc field. 

 

When you are done filling out the information 

click OK to save. 
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Create Points 

 

1. Go to the Data Tab and select Point Edit. 

 

2. Select the polygon into which you want to 

create or edit points in by selecting the correct 

polygon from the combo box in the top right 

corner of the page. Then to create a new point 

select New on the bottom of the page. 

To change the type of point operation click the 

Op button located under the PID textbox. 

To change whether a point is on or off bounda-

ry click the boundary button  

 

Edit Points  

To edit a point first unlock it by checking the 

Locked box. Edit the fields. 

 

Note:  

Changing the point type can not be undone 

when switching from a GPS type to a  

Sideshot or a Quondam type point.  

 

1. 

2. 

3. 
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Point Edit - GPS Point / Way Point 

1. In the Point Edit Form create a new point. 

Select the Op of GPS.  Click on the Acquire 

button located between OK and Delete. This 

will take you to the GPS logging page. 

2. In the GPS Logging page see the satellite  

information being received.  When the data 

looks good, click the Log GPS button.  

At anytime you have to ability to pause and  

resume collecting  data. When you feel you 

have collected enough data press the  

Calculate button to move on to the calcula-

tion form. 

3. On the calculation form select your filters. 

You can also change the group size to help see 

the quality of the data.  Click on the Calculate 

button on the bottom of the page to calculate 

or recalculate the position measurements.  

(Ordinarily, you want to use all the data.  But 

sometimes you need to eliminate beginning 

measurements, or other in-between  

measurements of bad reception, which may 

be done with the  checkboxes.) 

 

Notes: 

 Your filters will be saved to the device and applied 

throughout the program until you change them. 

 At anytime you can come back to a point that was 

generated with NMEA data and  

recalculate it via the ReCalc button in the Point Edit 

form (Image 1). 

1. 

2. 

3. 



8  

Point Edit - Take5 

1. In the Point Edit Form create a New point 

and then select the operation of Take5.  

(Unlike the GPS operation, the Take5 filters  

data before it is calculated and the  

measurements cannot be recalculated).  

The filters need to be initially set using the 

Take 5 Setup button (NOT THE Take5 

BUTTON). If you do not setup set your filters 

the default values will be used which is shown 

in image 2 (3d; 5 averaging;  and HDOP of 

20).   

From the filter you can click Hide to  

return to the point data. Click the Take 5 

button to begin.  You can return to the settings 

at any time. 

 

2. From the Take 5 form you can simply obtain 

a point that has been pre-filtered and  

automatically calculated by pressing the Take 5 

button on the bottom of the page. The top bar 

will fill up until you have collected all the 

NMEA needed. You can take as many points as 

you want while on this page. When you have 

collected all the points you need simply click 

Finish to return to the Point Edit page. 

1. 

2. 
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Point Edit - Take5 continued.. 

3. From the Take 5 form you can simply obtain 

a point that has been pre-filtered and  

automatically calculated by pressing the Take 5 

button on the bottom of the page. The top bar 

will fill up until you have collected all the 

NMEA needed. You can take as many points as 

you want while on this page. When you have 

collected all the points you need simply click 

Finish to return to the Point Edit page. 

 

4. If needed there is a simple way to add a 

Sideshot while in the Take 5 form. By pressing 

the SideShot button a form will pop up to add 

a point. Fill in the information and click  

Add SS to add the point. By clicking cancel or  

SideShot you can cancel creating the Sideshot. 

 

Notes:  

1. After you create a Take 5 point you can unlock the 

form and edit the point’s PID and add a comment to 

the point. 

2. If the top bar is not moving when you are col-

lecting data, check your filters, they may be set too 

high. 

3. 

4. 
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Point Edit - Walk 

1. In the Point Edit Form create a new point 

and then select the operation of Walk. Unlike 

the GPS or Take5 operation the Walk only  

collects 1 piece of NEMA data per point. Click 

the Walk button to begin. 

2. In the Walk Page uncheck Lock to edit the 

walk settings. You can edit the frequency of 

the walk points collected which is how often 

you collect the NMEA data. You can also set a 

minimum distance between each point as well 

as how well the point fix is.  When you are 

ready to begin the Walk click the Start button. 

You are able to pause and resume your walk if 

needed. When done press the Stop button. 

3. After a walk is created you are able to edit 

walk information such as setting a Manual 

Accuracy to all the walk points or Adding a 

specific point to a walk. You are also able to 

delete the entire walk if wanted. 

Notes: 

 When setting the Frequency note the NMEA data 

broadcast interval. If the interval is 1 second and you 

set the Frequency to 10, every 10 seconds you will 

collect a point. If the Interval is 2 second you will 

collect a point every 20 seconds. 

 You will see a white circle in the top left corner of 

the screen every time a point is collected. With 

sound turned on you will also hear a beep. 

1. 

2. 

3. 
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Point Edit - SideShot / Traverse Point 

(Traverse to Points or Doing Sideshots have similar  

data entry and are both explained here.) 

1. In the Point Edit Form create a new point and 

then select the Op of SideShot / Traverse. Proceed 

to fill in the information for the forward and/or 

backward Azimuth manually with information from 

your compass and tape or laser.  Horizontal 

distance is entered in the SlpDist cell with zero in 

the SlpAng cell. 

 

(You can automatically fill in the information using the Acquire button  

located between OK and Delete. This will use a connected Laser Range  

Finder to fill in as much data as it can.  The Bluetooth connections often fail 

during work and a wired connection gets tangled — automatic operation is 

rarely practical. (i.e. most of you are using a laser that does not give azi-

muth or if it does, it is frequently unreliable.) If using a distance meter, 

check the status of the connection on the bottom right of the screen above 

1. 

Notes: 

 You must enter at least a Forward or Backward azimuth to continue. 

 The Magnetic Declination for the measurement is obtained from the 

metadata defined in the Metadata Edit button in the main menu under the 

Data tab. 

 A Traverse must start and end with a GPS or Quondam type point.  

 A red number indicating azimuth error will show next to the  

backward azimuth when the forward and backward azimuth are not exactly 

180 different.  Up to 3 degrees is usually acceptable (ordinarily the lengths 

are not very long). 
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Point Edit – Quondam Point  

(Quondam: That which formerly exists.) 

 

1. In the Point Edit Form create a New point 

and then select the Op of Quondam. You will 

now select an existing point (parent point) 

whose exact position values will be used for 

this point.  To select a parent point select the 

polygon that the parent point is in, in the left 

list box. Then select the PID of the point on the 

right list box. 

 

2. (Legacy - see note below) To retrace several 

points select the Retrace button to enter the 

Quondam Retrace form. Within the Quondam 

Retrace form select the polygon which has the 

starting and ending point.  Proceed to select 

the start and end point and then select the di-

rection of your  

retrace. When you have selected all your  

information press the Retrace button to add 

several Quondams to your polygon. 

 

Note: Retracing can also be done in the  

Multi Point Edit form which is the preferred 

method.  

1. 

2. 
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Table Edit 

 

1. To Edit points via the Table Edit go to the 

Data Tab and select Table Edit. 

 

2. Within the Table Edit form you can modify 

point information. 

 

If needed, you can reset a point to its original 

values by selecting the ‘R’ button in the first 

field on the left of the table. No point changes 

will be saved until you click the Save button. If 

you forget to save, you will be prompted to do 

so as you leave this form. 

1. 

2. 



14  

Draw Map 

1. In the Tools tab select Draw Map. In this 

form you can select the polygons which you 

want to show visually. There are many settings 

on this page including showing points and 

lines of a polygon as well as labels for the 

points. 

2. Clicking the Display Element Options tab 

will bring more options which you can select.  

(On this page you also have the  

option to show your current location and the 

GPS coordinates used.) 

 

3. Once you have selected your options click 

Draw Map to enter the Map Form. Here you 

can use a mouse, pen or arrows to move the  

polygon(s) around. You can also use a mouse 

wheel and the zoombar to zoom in and out. To 

hide or show the zoombar, arrows and exit 

button, double click anywhere on the map. 

The button in the center of the arrows will 

center your polygon(s).  

 

Notes:  

1. If labels are disabled you can click on a 

point to see its PID. 

2. Selecting the Legend option will show what 

the different line colors mean. 

1. 

2. 

3. 
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Navigation using Draw Map 

1. From within the Draw Map form set Display 

Element Options tab to My Position.  Then 

press Draw Map  to show the map. 

 

2. This will show your position on the map as 

seen in figure 2. 

 

3. By checking the Follow Position option,  

polygons will follow you around the map. In 

this case you are the center dot as seen in  

figure 3. 

1. 

2. 

3. 
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How Am I Doing? 

 In the Tools tab select How am I doing?. In 

this form you will see the results of your work 

and the details and accuracy of the points as 

well as the area errors of the polygons.  

 

Notes:  

 On the PC version of TwoTrails you can save 

your results to a text file. You can also  

show/hide the points by click the Toggle Points 

button in the bottom right of the form. 
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Where Is 

1. In the Tools tab select Where Is. From this 

form you can calculate the direction and  

distance between points or your location. 

 

2. To Calculate the distance between two 

points select Point in the From section then 

Point in the To section. From here you can then 

select the polygon which the point resides and 

the point in that polygon.  From here simply hit 

Calculate to get the distance from the first to the 

second point. The information will be displayed 

according to the metadata you have chosen, 

which is shown on the bottom of the page. 

 

You can manual enter coordinates if you want. 

 

(Navigation can be done here or using the Map) 

 In this form to display the navigation select 

the Navigate button. This will show an arrow 

based on your location. The longer the arrow is 

the further your target it from your position. The 

arrow will also rotate towards the target from 

the direction you are walking.  If the arrow turns 

red you are more than 45° off from your  

intended direction.  

A message will pop up when you are within 5 

meters of your target. Press Stop to enter the 

navigation.  

1. 

2. 
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Export 

1. In the Tools 2 tab select Export. In this form 

you will be able to export your project in a 

multitude of formats. 

 

2. First select the Output Location of your  

project files. 

 

3. Continue to select what you would like to 

export. Points, Project, NMEA, Polygons and 

MetaData will be exported into CSV files.  

Summary will be sent out as a text file and 

KMZ and GPX will be sent out in their own  

formats. On the PC version of TwoTrails you 

will also have the option to export Shapefiles 

for use in ArcMap and a HTML file which can 

be viewed in a web browser which uses 

Google Maps. 

 

4. Press Export to generate and save the files 

to the output location. 

 

Note:  

Select or deselect all according to the options 

on the page. 

1. 

(Mobile) 

(PC) 
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Rename Points (Rearrange Points) 

(This operation is best done later in the office)  

1. In the Tools 2 tab select Rename Points. In 

this form you can rename and rearrange 

points. 

 

2. Select the polygon you want to work in by 

clicking and selecting the polygon in the top 

right corner.  

 

3. You can rename all the points by selecting 

Auto, the points will be renamed according to 

the polygon naming structure (found within 

the polygon form, fig 2), starting from the start 

point index, increasing by the point increment 

number. For example you could name 1010 to 

4010 and increment by 2 and then go back to 

the rename form.   

 

4. To rearrange points select the point you 

want to edit by clicking on the point. To move 

the point use the First, Up, Down and Last 

buttons. To rename the point simply enter the 

new name into the textbox.    

 

5. When you are done press Save to save all 

your points. Failing to press save will discard 

your changes. 

1. 

2. 
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Plot Grid 

1. In the Tools 2 tab select Plot Grid. In this 

form you can add sample  points to your  

polygon. 

2. First select inside or outside the polygon. By 

default this is within your polygon. 

3. Then select which polygon you would like to 

add sample points to. (This create a new  

polygon with only sample points, the polygon 

will have the name of ‘[your polygon]_plts’).  

4. Select unit-of-measurement between sam-

ple points.  

5. You may select the start point to rotate your 

points around, otherwise leave the option as 

Random. 

6. Select the grid interval (space between your 

points). This will be measured in the units you 

selected before. 

7. Select the tilt angle for the grid axis. 

8. Press Plot to generate the points. 

 

Notes: 

 You may repeatedly do this operation with 

different values. Previous values will be  

deleted unless you choose otherwise. 

 You also have the option to take a random 

sample of the systematic points by clicking and 

completing the sample box entries. 

1. 

Notes continued: 

 For large polygons with 

lots of points this process 

can take a considerable 

amount of time. Please 

be patient with the  

program. If needed you 

can cancel the  

operation by clicking the 

close button. 
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Multi Point Edit (Mobile) 

1. In the Tools 2 tab select Multi Point Edit. In 

this form you can edit whether a point is on 

boundary, convert a quondam its parent point 

and switch multiple points between polygons. 

 

2. Select the points that you want to edit by  

checking the check boxes. 

 

3. You can then turn those points on or off 

boundary by pressing the On/Off button on 

the top of the page. 

 

4. If you wish to switch the polygon these 

points reside in select the Switch polygon 

button on the bottom of the page. 

 

5. If these points are Quondams, you can  

convert them to their linked point by selecting 

Convert Quondam button located next to the 

switch polygon button. 

 

6. To delete points select Delete. 

 

7. When done making changes select the Save 

button. If you do not click save your changes 

will be discarded. 

 

Note: The Multi Point Edit on the PC is much  

easier to use as well as more  capable. 

1. 
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Multi Point Edit - PC 

(Reference pictures on next page) 

Duplicate the project or copy the file before using this tool. 

1. In the Tools 2 tab select Multi Point Edit. In this form you can edit almost 

everything about a point.   

Edit Point: To edit a point select the point you wish to edit inside the point view 

window. Then proceed to edit the details of the point on the right window 

which displays the point’s values. 

Edit Multiple Points: When multiple points are select you will be editing all of 

said point’s values. If the points are not of the same op type only similar values 

(like a comment or metadata) will be editable. If a field is colored or a drop 

down box does not show a value it means that points do not share the same 

value. 

Filter: The top section in this form is a filter which you can filter points in the 

point view window. The basic filters which you can use are Polygons, Op Type, 

MetaData used, Groups, PIDs and descriptions/comments.  

By selecting Show More Options you can filter by more exact information.  

Under General and GPS Types you can filter points by their X Y and Z values, 

manual accuracy, RMSEr and whether the point in on or off boundary. Under 

Traverse and Sideshots you can filter points by their forward and backward  

azimuth, slope distance and slope angle. Under Quondams you can filter points 

based on whether they have linked points (Quondams) attached to them. For 

any of the extra filters you must specify if the filter should be used by checking 

the Use Filter in the top right of the filter box. 

Editing: The Mass Point Edit form on the PC remembers what you have done 

with the points you edited. This allows you to use Ctrl + Z to undo an action you 

have done to one or several points. You can also use Ctrl + Shift + Z to redo an 

action that you have undone. If you wish to reset the values of one or many 

points to the last save you can press Ctrl + Shift + R to reset a point’s value.  

Under Edit you can also Reset all of the points.  
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Mass Point Edit (PC) Continued 

Duplicate the project or copy the file before using this tool. 

Change Polygon: To change the location 

of points into a different polygon right 

click a point and select Change Polygon. 

Here inside the Point Location  

Manipulation form you will select 

which polygon you wish to move your 

point to, then where in the polygon you 

wish to set your point(s). You have the 

options to set your point(s) at the end 

or beginning of the polygon as well as after a specific point. You also must  

select a direction. By selecting reverse all the points that are select will be  

inserted in the opposite direction. Click Commit to change the location of your 

points. 

Quondam Points: In the Point View Window select the points you wish to 

quondam then right click Quondam Points. Here you will see the Point  

Location Manipulation form. You have the options to quondam your point(s) 

at the end or beginning of the polygon as well as after a specific point. You also 

must select a direction. By selecting reverse all the points that are select will be 

inserted in the opposite direction. Click Commit to quondam your points into 

another polygon. 
 

Notes: 

1. In the Mass Point Edit form some actions can not be undone within the form. Some of 

these include creating new Polygons and Groups. When you reset a point you also lose the 

ability to undo the reset. 

2. When you save within this form you also can not undone any of the actions. After  

saving and then editing when resetting a point it will be reset to the save point. 

3. After deleting a point then saving you are unable to recover said point. Do not delete 

points unless you are absolutely sure you do not need it. It may be better to just take the 

point off boundary. 
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GPS Logger 

1. In the Tools 2 tab select GPS Logger. In this 

form you can log NMEA data. 

2. To log NMEA data first make sure your GPS 

device is setup and connected. Then click the 

Log button. 

3. If you wish you can save the NMEA data to a 

file. To do this you can click on the textbox to 

select your location then check the Log To File 

checkbox. Click Log now will save the data to a 

file. 

4. When done logging press Stop. Without 

pressing stop the device will continue logging 

the data in the background. 

1. 
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Google Map / Google Earth (PC) 

1. In the Tools 2 tab you have the option to 

view your data in Google Map and Google 

Earth.  

2. Selecting Google Map will open your data 

up in a web browser. 

3. Selecting Google Earth will open up your 

data using the Google Earth program. 

Notes: 

You must have a compatible web browser to 

use the Google Map feature. Google Earth 

must also be installed to use the Google Earth 

feature. 
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Group Edit (PC)  

1. In the Tools 2 tab Go to the Group Edit. In 

this form you can edit, add and remove 

groups. Groups are ways to associate a  

number of points in order to edit them  

together.  

2. Fist select the group you want to edit. Then 

you can edit the name or description of the 

group by select the name or description  

textbox and editing them. 

3. To delete a group press the Delete button. 

Note that when you delete a group it does 

NOT delete the points inside the group. It 

does however delete the group permanently. 

If you delete a group the only way to recreate 

it is to add another group and move points in-

to it manually. 

4. To Add a group select the Add button. 

5. The Change of names, descriptions and 

types will need to be saved. Without clicking 

Save, all changes will be discarded. 
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Polygon Transformation (PC) 

1. In the Tools 2 tab select Polygon Transformation.  In this form you can  

Translate, Rotate and Scale a polygon. 

2. To Translate a polygon check the Translate 

checkbox. Here you can either translate a polygon 

manually by giving it a distance to move by or 

having a Point align to another point inside  

another polygon. 

3. To Rotate a Polygon check the Rotate  

checkbox. Here you have the ability to rotate a 

polygon by a specific angle or align two sets of 

points from two polygons. To align by two  

polygons select the Points option then proceed to 

select the reference polygon and the adjusting 

polygon as well as the points inside the polygons 

that will be aligned. To adjust by an Angle select 

the Angle option. Here you can rotate by the  

reference point or an adjusted point. 

4. To Scale the polygon check the checkbox under 

the Scale tab. Here you can scale the polygon 

manually or by aligning points. When scaling by 

points, the polygon will scale the first reference 

point. When scaling manually the polygon will 

scale from its center.  

5. When all your settings are set press the  

Transform button. Once this is clicked there is no 

un-doing. It is suggested to preform this  

operation on a copy of a polygon. 
 

Note: This task does NOT actually move your polygon, but rather creates a new 

polygon that is transformed. 
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Help 

If you are experiencing an issue with the program or have gotten an error mes-

sage, you can contact Gary Boyack (gboyack@fs.fed.us) or Bryan Miller 

(bryancmiller@fs.fed.us) for help with the issue. When contacting please attach 

an exported package that includes the project you are working on as well as the 

log file from the device with the issue. 

 

How To Export an Error Log: 

To create an exported package, go to the settings tab and click on Export Log. It 

will ask you if you want to add the current project. Select yes. Choose a location 

to save the export and then select OK.  

 

 


